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Titanyum Alaşımının Yüksek-Hızlı İşleme Süreci: Kapsamlı Sonlu 

Eleman Modelleme 

High-Speed Machining Process of Titanium Alloy: A Comprehensive 

Finite Element Modeling 

Önemli noktalar (Highlights) 

❖ Titanyum alaşımının talaş oluşumu süreci için kapsamlı sonlu eleman (SE) modelleme / A comprehensive 

finite element (FE) modeling for chip formation process of titanium alloy 

❖ Yüksek hızlı işleme sırasında talaş oluşumu üzerinde çeşitli talaş açılarının etkisi / Impact of a variety of rake 

angles on chip formation during high-speed machining 

❖ Talaş şekli, iş parçası yüzeyi, eşdeğer gerilme, gerinim ve kesme kuvveti gibi parametrelerin analizi / 

Analysis of parameters such as chip shape, workpiece surface, equivalent stress, strain and cutting force 

Grafik Özet (Graphical Abstract) 

Bu çalışma, titanyum alaşımının talaş oluşumu süreci için SE modelleme ve benzetimini ele almaktadır. / This study 

deals with FE modeling and simulation for chip formation process of titanium alloy. 

 

Şekil. Talaş oluşumu için SE modeli / Figure. The FE model for chip formation 

Amaç (Aim) 

Bu çalışma, talaş oluşumu benzetimi yapmak için iki boyutlu SE modeli sunmayı amaçlamaktadır. / This study aims 

to present a two-dimensional FE model for simulating the chip formation. 

Tasarım ve Yöntem (Design & Methodology) 

Talaş şekli, iş parçası yüzeyi, gerilme, gerinim ve kesme kuvvetini içeren temel parametreler SE yöntemiyle tahmin 

edilmiştir. / The basic parameters, including chip shape, workpiece surface, stress, strain and cutting force, are 

predicted with the FE method. 

Özgünlük (Originality) 

Yüksek kesme hızı altında talaş oluşumu sürecini incelemek için kapsamlı bir SE modeli takdim edilmiştir. / A 

comprehensive FE model is introduced to study the chip formation process under high cutting speed. 

Bulgular (Findings) 

Talaş şekilleri, takım talaş açısıyla değişmektedir. Talaş açısının pozitif yöndeki artışı kesme kuvvetinin azalmasına 

yol açmaktadır.  / The chip shapes vary with the tool-rake angle. An increase in the positive direction of rake angle 

causes a decrease of cutting force. 

Sonuç (Conclusion) 

Bu model, yüksek hızlı işlemede talaş açısının önemli bir rol oynadığını göstermektedir. / This model indicates that 

the rake angle plays a key role in high-speed machining. 

Etik Standartların Beyanı (Declaration of Ethical Standards) 

Bu makalenin yazar(lar)ı çalışmalarında kullandıkları materyal ve yöntemlerin etik kurul izni ve/veya yasal-özel bir 

izin gerektirmediğini beyan ederler. / The author(s) of this article declare that the materials and methods used in this 

study do not require ethical committee permission and/or legal-special permission. 
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 ÖZ 

Bu çalışma, titanyum alaşımının talaş oluşumu süreci için iki boyutlu sonlu eleman (SE) modelleme ve benzetimini kapsamlı bir 

şekilde ele almaktadır. Yüksek hızlı işleme sırasında çeşitli talaş açılarının etkisini incelemek için talaş şekli, iş parçası yüzeyi, 

eşdeğer gerilme, plastik gerinim ve kesme kuvveti gibi temel parametreler analiz edilmiştir. Talaş şekilleri, takım talaş açısıyla 

değişmektedir. Testere ağızlı talaş oluşumu sırasında, birincil deformasyon bölgesi, ikincil bölgeden önemli ölçüde daha yüksek 

gerilme sergilemektedir. Ayrıca, yüksek gerinimler talaş köklerinde meydana gelmiştir. Testere ağızlı talaşın neden olduğu kesme 

kuvveti dalgalanması, sürekli talaş oluşumu sırasında elde edilenden daha belirgindir ve kuvvet periyodik olarak değişmektedir. 

Sonuçlar, talaş açısının pozitif yöndeki artışının kesme kuvvetinde azalmaya ve daha pürüzsüz bir iş parçası yüzeyine yol açtığını 

da göstermektedir.   

Anahtar Kelimeler: Talaş oluşumu, SE modelleme, yüksek-hızlı işleme, titanyum. 

High-Speed Machining Process of Titanium Alloy: A 

Comprehensive Finite Element Modeling 

ABSTRACT 

This study comprehensively deals with a two-dimensional finite element (FE) modeling and simulation for chip formation process 

of titanium alloy. The basic parameters, such as chip shape, workpiece surface, equivalent stress, plastic strain and cutting force, 

are analyzed to study the impact of a variety of rake angles during high-speed machining. The chip shapes vary with the tool-rake 

angle. During the serrated chip formation, the primary deformation region exhibits substantially higher stress than secondary region. 

Also, the higher strains are occurred at the chip roots. The fluctuation of the cutting force caused by the serrated chip is more 

prominent than that obtained during the continuous chip formation, and the force varies periodically. The results also show that an 

increase in the positive direction of rake angle causes a decrease in cutting force and a smoother workpiece surface. 

Keywords: Chip formation, FE modeling, high-speed machining, titanium.

1. GİRİŞ (INTRODUCTION) 

Sonlu elemanlar (SE) yöntemi, talaş kaldırma süreçlerini 

modellemek için yararlanılan kullanışlı bir yöntemdir. 

SE yöntemi kullanılarak, gerilme ve gerinim dağılımı 

gibi deneylerle bulunması oldukça zor olan çeşitli 

değişkenler doğru olarak tahmin edilebilir. Bu yüzden, 

birçok araştırmacı süreç performansının analizi ve 

eniyilemesi için zaman alıcı ve maliyetli fiziksel 

deneylerin yerine SE yöntemini kullanmıştır [1-3]. 

Titanyum alaşımları, yüksek mukavemeti, düşük 

yoğunluğu ve mükemmel korozyon direnci nedeniyle 

havacılık ve otomotiv endüstrisinde yaygın olarak 

kullanılmaktadır. Ancak, düşük talaş kaldırma oranı ve 

ciddi takım aşınması nedeniyle titanyum alaşımlarının 

işlenmesi zordur. Bu alaşımların yüksek hızda işlenmesi 

sırasında, genellikle testere ağızlı talaşlar üretilir ve bu 

durum kesme kuvvetlerinde ciddi dalgalanmalara, takım 

aşınmasının artmasına ve iş parçası yüzey kalitesinin 

kötüleşmesine yol açar [4]. İş parçası yüzey kalitesini ve 

takımların ömrünü iyileştirmek için yüksek hızlı kesme 

sırasında kesici takım talaş açısının işlenen iş parçasının 

deformasyonu, kesme kuvveti, gerilme dağılımı, talaş 

şekli ve talaş oluşum mekanizması üzerindeki etkisinin 

anlaşılması gerekir. Bu amaçla kesme kuvvetleri [5], 

kesici takım gerilmeleri [6] ve takım aşınması [7] gibi 

performans değişkenleri SE yöntemi ile analiz edilmiştir. 

Yüksek hızlı işlemede talaşların şekli, malzemelerin 

özelliklerine ve kesme koşullarına bağlıdır. Düşük 

karbonlu çelikler gibi, düşük sertlikteki malzemelerin 

işlenmesi sırasında kararlı kesme kuvvetleri oluşturan 

sürekli talaşlar elde edilir. Titanyum alaşımları gibi, 

yüksek sertlikteki malzemeler geniş bir kesme hızı 

aralığında testere ağızlı talaşlar ve daha yüksek kesme 

hızlarında kesikli talaşlar üretirler [8]. Literatürde talaş 

oluşumunun çeşitli yönleri incelenmiştir. Sürekli talaştan 

testere ağızlı talaşa geçişin, kesme işlemindeki plastik 

kararsızlık nedeniyle birincil kayma bölgesindeki termal 

yumuşama ve deformasyon sertleşmesinden 

kaynaklandığı gösterilmiştir [9]. Aynı zamanda, birincil 

deformasyon bölgesindeki yerel termal yumuşamanın 

adyabatik kayma bantlarının oluşumuna neden olduğu 

öne sürülmüştür [10]. Arrazola ve arkadaşları [11] süreç 

parametrelerinin testere ağızlı talaşlar üzerindeki 
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duyarlılığını analiz etmişlerdir. Sonuçlar, kesici takım 

talaş açısının ve kesme hızının testere ağızlı talaş 

oluşumu üzerinde güçlü bir etkisinin olduğunu ortaya 

çıkarmıştır. Ambati ve Yuan [12] farklı plastik yer 

değiştirme değerlerini içeren ardışık hasar modelini 

kullanarak çeşitli talaş şekillerini analiz etmişler ve 

ilerleme artışıyla sürekli talaştan testere ağızlı talaşa 

geçişin gerçekleştiğini göstermişlerdir. Yüksek kesme 

hızlarında birçok malzeme testere ağızlı talaş 

oluşturmaktadır. Isıl işlem görmüş AISI1045 çeliği [13], 

Ti6Al4V titanyum alaşımı [14, 15] ve nikel esaslı Inconel 

718 alaşımı [16] üzerinde SE yöntemiyle testere ağızlı 

talaş oluşumunun sayısal benzetimleri yapılmıştır. 

Ayrıca, Wang ve arkadaşları [17] alüminyum alaşımının 

mikro frezelemesi sırasında talaş oluşumunu incelemek 

için iki boyutlu SE yaklaşımını kullanmışlardır. SE 

benzetiminden talaş hızı, gerinim hızı, temas basıncı, 

kesme kuvveti ve talaş akışını tahmin etmişlerdir. Ding 

ve arkadaşları [18] kanal ve kenar frezeleme koşullarında 

sertleştirilmiş takım çeliğinin mikro parmak frezeleme 

benzetiminden sürekli talaş elde etmişlerdir. Kesme 

kuvvetlerini, talaş oluşumunu, gerilme, sıcaklık ve hız 

dağılımlarını analiz etmişlerdir.  

Talaş kaldırma işleminin SE analizi, genellikle Eulerian 

veya Lagrangian sınırlarına sahip yeniden ağ oluşturma 

tekniği ile gerçekleştirilmektedir [19, 20]. Bu çalışmada, 

titanyum alaşımı için yüksek hızlı işleme sürecinin 

benzetimini gerçekleştirmek amacıyla yeniden ağ 

oluşturma tekniğinin yerine eleman silme tekniğinin 

uygulandığı bir SE modeli sunulmuştur. Daha sonra, 

kesici takım talaş açısının talaş şekli, iş parçası yüzeyi, 

eşdeğer gerilme, gerinim alanı ve kuvvet büyüklükleri 

üzerindeki etkileri araştırılmıştır. 

 

2. TALAŞ OLUŞUMUNUN SE MODELİ (FE 

MODEL OF CHIP FORMATION) 

Ti6Al4V titanyum alaşımının talaş oluşumu işlemi için 

iki boyutlu SE modeli JC malzeme ve hasar yasası 

kullanılarak Abaqus/Explicit yazılımında hazırlanmıştır. 

 

2.1. İş Parçası ve Takım Geometrik Modelleri 

(Workpiece and Tool Geometric Models) 

İş parçası geometrik modelini oluşturmak için Part 

modülünde menü çubuğundan Part→Create seçilmiştir. 

Açılan Create Part diyalog kutusunda iş parçası 

modelinin adı Base, modelleme boşluğu 2D Planar, 

model tipi Deformable, temel unsur Shell ve yaklaşık 

boyut 5 olarak ayarlanmıştır. Eskiz çizim modülünde iş 

parçası geometrik modeli, Şekil 1’de gösterildiği gibi, 

0.52 mm × 2 mm boyutlarında oluşturulmuş ve talaş 

katmanını, alt kısımdan daha fazla elemanla modellemek 

için iki farklı alana bölünmüştür. 

Kesici takım geometrik modelini oluşturmak için de 

Create Part diyalog penceresinden iki boyutlu modelleme 

boşluğu seçilmiştir.  Model tipi Analytical rigid ve 

yaklaşık boyut 5 olarak ayarlanmıştır. Şekil 2’de 

gösterildiği gibi, kesici takım 0.025 mm uç yarıçaplı ve 

6 boşluk açılı () olarak modellenmiştir. Kesme 

sırasında takım talaş açısı () talaş şeklini etkileyen 

önemli bir faktördür [21]. Bu nedenle, talaş açısının talaş 

şekli üzerindeki etkisini incelemek için kesme analizi 

geniş bir talaş açısı aralığında (−30, 0 ve 30) 

gerçekleştirilecektir. 

 

 

Şekil 1. İş parçası (Workpiece) 

 

Eskiz çizildikten sonra, menü çubuğundan 

Tools→Referans Point seçilmiş ve takımın sağ üst köşesi 

referans noktası olarak tanımlanmıştır. Böylece, kesme 

hızı uygulanabilecek ve kesme kuvveti kolaylıkla elde 

edilebilecektir. 

 

 

Şekil 2. Kesici takım (Cutting tool) 

 

2.2. Elemanlara Ayırma ve Örgü Parça Oluşturma 

(Meshing and Mesh Part Creation) 

SE ağını oluşturmadan önce, iş parçası kenarları 

üzerindeki ağ gözü sayısını ayarlamak için menü 

çubuğundan Seed→Edges ve Şekil 3’te gösterilen A, B 

ve C kenarları sırasıyla seçilerek ağ gözü sayısı 250, 25 

ve 8 olarak tanımlanmıştır. 

Ağ gözü sayısı ayarlandıktan sonra, iş parçası modelinin 

ağ şekli kontrol parametrelerini tanımlamak için menü 

çubuğundan Mesh→Controls seçilmiştir.  Açılan Mesh 

Controls diyalog penceresinde dörtgen (Quad) eleman 
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şekli ve hesaplamayı daha kolay ve daha hızlı hale 

getirebilen Structured ağ oluşturma tekniği ayarlanmıştır. 

 

 

Şekil 3. Ağ gözü sayısı ayarlanmış iş parçası geometrisi 

(Seeded workpiece geometry) 

 

Sonraki adımda, eleman tipini ayarlamak için menü 

çubuğundan Mesh→Element Type ve tüm iş parçası 

çerçeve içine alınarak seçilmiştir. Şekil 4’te gösterildiği 

gibi, Element Type diyalog kutusunda Coupled 

Temperature–Displacement eleman ailesi ve eleman 

kontrol seçeneklerinde Plane strain analiz tipi 

tanımlanmıştır. İkincil hesaplama doğruluğu ve Relax 

stiffness hourglass kontrol seçenekleri de işaretlenmiştir. 

Analiz sırasında aşırı eleman bozulmalarını önlemek için 

distorsiyon kontrol değeri 0.08 olarak girilmiş [22] ve 

geri kalan seçenekler varsayılan olarak ayarlanmıştır. 

Şekilde görüldüğü gibi, iş parçasını elemanlara ayırmak 

için iyi bir kararlılığa sahip dört düğümlü eleman tipi 

(CPE4RT) kullanılmıştır. İş parçası modeli, 8250 eleman 

ve 8534 düğümden oluşmaktadır. 

 

 

Şekil 4. Eleman tipi (Element type) 

 

Son olarak, ağ oluşturma işlemini tamamlamak için menü 

çubuğundan Mesh→Part ve SE ağı oluşturulmuş iş 

parçasını Base-mesh olarak tanımlamak için menü 

çubuğundan Mesh→Create Mesh Part seçilmiştir. Şekil 

5’te gösterildiği gibi, yeşil bir örgü iş parçası 

oluşturulmuştur. Sonraki modelleme işlemleri, bu örgü iş 

parçasına dayanmaktadır. 

 

Şekil 5. Örgü parça modeli (Mesh part model) 

 

2.3. Malzeme Özellikleri (Material Properties) 

Talaş kaldırma işleminde, iş parçası malzemesi yüksek 

gerinim hızı ve sıcaklık altında deformasyona uğrar. 

Yüksek hızlı kesme koşullarında, SE benzetimlerini 

başarılı bir şekilde gerçekleştirmek için güvenilir akış 

gerilmesi modelleri kullanmak gereklidir. Malzemelerin 

akış gerilmesi özelliklerini tanımlamak için Johnson-

Cook (JC) modeli  [23], Usui modeli [24] ve yarı 

deneysel Zerilli modeli [25] gibi çeşitli yapısal modeller 

geliştirilmiştir. Bu çalışmada, iş parçası malzemesinin 

akış gerilmesini tanımlamak için Denklem (1)’de verilen 

JC modeli kullanılmıştır. Bu model, büyük gerinimlerin, 

yüksek şekil değiştirme hızlarının ve sıcaklığa bağlı 

visko-plastik deformasyonun dahil edildiği işlemlerde 

metallerin ve alaşımlarının davranışını tatmin edici bir 

şekilde tanımlamaktadır. 

 
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
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



 (1) 

burada σ  eşdeğer gerilme, 
pl

ε  eşdeğer plastik gerinim, 
pl

ε  eşdeğer plastik gerinim hızı, 0ε
  referans gerinim 

hızı (1/s), A malzemenin akma mukavemeti, B sertleşme 

modülü, C gerinim hızına bağlı malzeme sabiti, n iş 

sertleşme üssü, m termal yumuşama katsayısı,  işlem 

sıcaklığı, θm (Ti6Al4V için 1605C) malzeme ergime 

sıcaklığı ve θ0 (25C) ortam sıcaklığıdır [26]. 

Talaş oluşumu benzetimlerinde bir hasar modeli de 

kullanılır. Bu model, Şekil 6’da verildiği gibi, sünek bir 

malzemenin hasar gelişimini gösteren tek eksenli 

gerilme-şekil değiştirme eğrisi ile verilebilir. Şekilde, 

sürekli eğri, hasarlı gerilme-gerinim davranışını ve 

kesikli eğri, hasar olmadığında görülen davranışı temsil 

etmektedir. 

Sünek kırılma ile talaş oluşumu iki aşamada gerçekleşir. 

İlk aşama hasarın başlatılması ile ilgilidir, ikincisi ise 

kırılma enerjisi yaklaşımına dayalı hasar gelişimi ile 

ilgilidir. 

Hasar başlangıç kriteri olarak Denklem 2’de sunulan JC 

hasar modeli [28] kullanılmıştır. Denklem (3) ile ifade 

edilen skaler hasar parametresi (ω) 1’i aştığında hasarın 

başladığı varsayılır. 
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Şekil 6. Gerilme-gerinim eğrisi (Stress-strain curve) [27] 
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burada 
pl

oε  hasar başlangıcındaki eşdeğer plastik 

gerinim, P hidrostatik basınç,  σP  gerilme üç 

eksenliliği, D1−D5 JC hasar parametreleri ve 
pl

ε

eşdeğer plastik gerinim artışıdır. 

Hasar gelişimi sırasında, gerilme-gerinim ilişkisi 

malzeme davranışını tam olarak temsil etmez. Bu 

nedenle, Hillerborg ve arkadaşları [29] tarafından 

önerilen kırılma enerjisi formülasyonu hasarın 

başlamasından sonra yer değiştirme-gerilme tepkisi 

oluşturarak ağ bağımlılığını azaltmak için kullanılır. 

Birim çatlak alanını elde etmek için gerekli kırılma 

enerjisi (Gf), Denklem (4)’te verilen Hillerborg’un 

kırılma enerjisi ile ifade edilebilir: 

==
pl
f

pl
f
pl

o

u pl

y

ε

ε

pl

y uεLG 0f dd   (4) 

Denklem 4’te, 
pl

fε  kırılma anındaki eşdeğer plastik 

gerinim, L bir elemanın karakteristik uzunluğu ve y  

akma gerilmesi, 
pl

u  eşdeğer plastik yer değiştirme ve 
pl

fu  kırılma anındaki eşdeğer plastik yer değiştirmedir. 

Ağ bağımlılığını azaltmak için kırılma enerjisine dayalı 

doğrusal hasar gelişim parametresi Denklem (5)’te 

verildiği gibi ifade edilir: 

pl

f

pl

pl

f

pl

u

u

u

L
D ==
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burada 
pl

fu  Denklem (6) ile hesaplanabilir [30]: 

y0

f2



G
u

pl

f =  (6) 

burada y0  hasar kriterine ulaşıldığı andaki akma 

gerilmesi değeridir. 

Her bir integrasyon noktasında hasar değişkeni (D) 1’e 

eşit olduğunda, eleman tamamen hasar gördüğü için 

Abaqus yazılımı tarafından sağlanan eleman silme 

tekniği ile ortadan kaldırılır. Tamamen hasar görmeyen 

elemanlar ise talaşı oluşturur. 

Hasar gelişimi için gerekli kırılma enerjisi (Gf) Denklem 

(7) ile belirlenebilir [31]: 

2
2

f

1
CK

E
G 




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

 −
=


 (7) 

burada E malzemenin elastikiyet modülü, υ Poisson 

oranı, KC çatlak gelişimi için kırılma tokluğu sabitidir. 

Ti6Al4V titanyum alaşımı iş parçası malzemesinin 

özellikleri Çizelge 1’de verilmiştir. JC malzeme 

parametreleri de Çizelge 2’de sunulmuştur. Parametreler 

0.0001, 0.1 ve 2150 s−1 şekil değiştirme hızlarında ve en 

yüksek 0.57 plastik gerinim seviyesinde belirlenmiştir 

[32].

 

Çizelge 1. İş parçası malzemesinin özellikleri (The properties of workpice material) [33] 

Yoğunluk 

(kg/m3) 

Elastikiyet modülü 

(GPa) 
Poisson oranı 

Isıl iletkenlik 

(W/mK) 
Özgül ısı (J/kgK) 

Isıl genleşme 

katsayısı (1/K) 

4430 109 (50C) 

91 (250C) 

75 (450C) 

0.34 6.8 (20C) 

7.4 (100C) 

9.8 (300C) 

11.8 (500C) 

611 (20C) 

624 (100C) 

674 (300C) 

703 (500C) 

9  10−6 

 

Çizelge 2. JC malzeme modeli sabitleri (JC material model constants) [34] 

A (MPa) B (MPa) n C m D1 D2 D3 D4 D5 

862 331 0.34 0.012 0.8 −0.09 0.25 −0.5 0.014 3.87 
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Ti6Al4V olarak tanımlanacak yeni bir malzeme 

oluşturmak için Property modülüne girilmiş ve menü 

çubuğundan Material→Create seçilmiştir. Açılan Edit 

Material diyalog kutusunda sırasıyla General→Density 

öğelerine tıklanarak yoğunluk değeri girilmiştir. 

Mechanical→Elasticity→Elastic seçilmiş ve veri 

sekmesinde,  elastikiyet modülü ve Poisson oranı 

değerleri tanımlanmıştır. Malzemenin plastik davranışını 

tanımlamak için Mechanical→Plasticity→Plastic öğeleri 

seçilmiştir. Hardening seçeneği Johnson-Cook olarak 

ayarlanmıştır. C değeri 0.012 ve Epsilon sıfır noktası 

değeri 1 olarak girilmiştir. Bu parametreler, gerinim 

hızının malzeme özellikleri üzerindeki etkisini 

göstermektedir. Malzemenin hasar parametrelerini 

ayarlamak için Mechanical→Damage for Ductile 

Metals→Johnson-Cook Damage ve hasar gelişimi kriteri 

olarak kırılma enerjisi seçilmiştir. Malzeme ısıl 

iletkenliğini tanımlamak için Thermal→Conductivity 

seçilmiş ve Conductivity veri sütununda sıcaklığa bağlı 

olarak veriler girilmiştir. Malzeme genleşme katsayısı 

Mechanical→Expansion seçilerek ayarlanmıştır. Özgül 

ısı kapasitesi için Thermal→Specific Heat seçilmiş ve 

sıcaklığa bağlı olarak veriler girilmiştir. Inelastic heat 

fraction için varsayılan değer kullanılmıştır. 

 

2.4. Kesit Tanımlama ve Atama (Section Description 

and Assignment) 

Kesit oluşturmak için menü çubuğundan 

Section→Create seçilmiş ve Section-Base kesiti 

tanımlanmıştır. Malzeme Ti6Al4V ve düzlemsel 

gerilme/gerinim kalınlığı 1 olarak ayarlanmıştır. 

Kesit atama işleminden önce bir eleman seti 

oluşturulmalıdır. Eleman seti için menü çubuğundan 

Tools→Set→Create seçilmiştir. Açılan Create Set 

diyalog kutusunda eleman seti Base-el olarak 

tanımlanmış ve Type sekmesinde Element 

işaretlenmiştir. Daha sonra, tüm iş parçası fare ile çerçeve 

içine alınarak işlem tamamlanmıştır. Eleman seti 

oluşturulduktan sonra, geometriye kesit atamak için 

menü çubuğundan Assign→Section seçilmiş ve Base-el 

eleman seti ayarlanmıştır. Edit Section Assignment 

diyalog kutusundaki kesit sekmesinde Section-Base 

kesiti seçilerek kesit tipi ve atanan malzeme 

tanımlanmıştır. Kesit malzemesi atama işlemi 

tamamlandığında örgü iş parçasının rengi, Şekil 7’de 

sunulduğu gibi, kesit atama işleminin başarılı olduğunu 

göstermek için açık yeşile değişmektedir. 

 

 

Şekil 7. Atanan kesit (Assigned section) 

 

 

2.5. Model Montajı (Model Assembly) 

Parçaların montajını yapmak ve kesici takımı iş parçasına 

göre konumlandırmak için Assembly modülüne girilmiş 

ve menü çubuğundan Instance→Create seçilmiştir. 

Açılan Create Instance diyalog kutusunda Base-mesh ve 

Tool seçilmiş, Dependent (mesh on part) öğesi 

ayarlanmış ve böylece Base-mesh ve Tool çizim 

bölgesinde görüntülenmiştir. 

Montajın koordinat orijini, varsayılan olarak iş parçası ve 

takımın koordinat orijini ile çakışmaktadır. Kesici takım 

ucunu kesme derinliğine taşımak için menü çubuğundan 

Instance→Translate seçilmiştir. Taşıma için başlangıç ve 

bitiş noktalarının koordinatları izafi değerler olarak 

girilir. Varsayılan başlangıç taşıma noktası koordinatı 

0,0’dır. Bitiş noktası koordinatları 0.001, 0.1 olarak 

girilmiştir. Böylece kesici takım 0.1 mm’lik kesme 

derinliğine ayarlanmıştır. Burada kesici takımın iş 

parçasına yeterince yakın olmasına, ancak ilk 

penetrasyon gerçekleşmemesine dikkat edilmelidir. 

Takım iş parçasına çok uzaksa, kesme işlemi geç 

başlayacaktır. Çok yakınsa, ara yüz oluşur ve takım ile iş 

parçası arasındaki temas ilişkisi etkilenir. Şekil 8 iş 

parçası ve kesici takımın konumunu göstermektedir. 

 

 

Şekil 8. Parçaların montajı (Assembly of parts) 

 

2.6. Analiz Tipi ve Çıktılar (Analysis Type and 

Outputs) 

Analiz adımını tanımlamak için Step modülüne girilmiş 

ve menü çubuğundan Step→Create seçilmiştir. Create 

Step diyalog kutusunda, analiz adımının adı Cutting 

olarak tanımlanmıştır. Bu adım, başlangıç analiz 

adımından sonra eklenmektedir. Analiz adımı tipi 

Dynamic, Temp-disp, Explicit olarak seçilmiştir. Time 

period, 1.5 mm işleme uzunluğu ve 300 m/dak kesme hızı 

hesaba katılarak 0.0003 s ve geri kalan seçenekler 

varsayılan olarak ayarlanmıştır. 

Abaqus varsayılan çıktı öğeleri sağlamaktadır. Sistem 

tarafından ayarlanan varsayılan çıktı öğeleri Field Output 

Requests Manager diyalog kutusunda, F-Output-1 

seçilerek Edit Field Output Request ara yüzünde 

görüntülenebilir. 

 



Mehmet AYDIN  / POLİTEKNİK  DERGİSİ, Politeknik Dergisi, 2022 ; 25(2) : 813-826 

 

818 

2.7. Temas ve Rijit Cisim Kısıtlamaları (Contact and 

Rigid Body Constraints) 

Talaş kaldırma benzetimi gerçekleştirmek için, takım-

talaş ara yüzü boyunca normal (n) ve sürtünme kayma 

(f) gerilme dağılımları modellenir [35]. Bu dağılımlar, 

Şekil 9’da gösterildiği gibi, temsil edilir. Zorev’in 

modeline [36] göre, kuru kesme koşularında işleme 

sırasında takım talaş yüzeyinde aynı anda iki bölge 

mevcuttur. Takımın ucundan bir noktaya kadar, takım-

talaş temas alanında yapışma bölgesi oluşur ve yapışma 

bölgesindeki sürtünme kayma gerilmesi (τf) talaş 

üzerindeki takım-talaş ara yüzündeki ortalama kayma 

akış gerilmesine (ktalaş) eşittir )( talaşf k= . Bu noktadan 

sonra, Coulomb sürtünme yasasının uygulanabileceği 

kayma bölgesi oluşur ve sürtünme kayma gerilmesi, 

sürtünme katsayısı (μ) kullanılarak belirlenebilir. 

 

 

Şekil 9. Talaş yüzeyindeki gerilme dağılımları (Stress distributions on rake face) [36] 

 

Talaş yüzeyindeki normal gerilme dağılımı (n) ve 

sürtünme katsayısı (μ) bilindiğinde, sürtünme gerilmesi 

(f) Denklem (8) ve (9) kullanılarak belirlenebilir: 

,)( talaşf kx = talaşn )( kx   (yapışma bölgesi)          (8) 

),()( nf xx  = talaşn )( kx   (kayma bölgesi) 

(9) 

Yapışma bölgesinin uzunluğu (lp) ve takım-talaş temas 

uzunluğu (lc), SE benzetimi sürtünme modelinde 

kullanılamamaktadır. Bu çalışmada, takım-talaş 

sürtünmesi Coulomb sürtünme yasasına dayalıdır. 

Sürtünme katsayı (μ), 0.3 değerine ayarlanmıştır [37]. 

Bir temas oluşturmadan önce kesici takım temas yüzeyini 

ve iş parçası düğüm setini tanımlamak gereklidir. Kesici 

takım temas yüzeyini oluşturmak için Interaction 

modülüne girilmiştir. View→Assembly Display Options 

seçilmiş, Assembly Display Options diyalog kutusundaki 

Instance sekmesinde sadece Tool-1’in görüntülenmesi 

sağlanmıştır. Daha sonra, menü çubuğundan 

Tools→Surface→Create seçilerek açılan Create Surface 

diyalog kutusunda yüzey adı Tool_surf ve tipi Geometry 

olarak tanımlanmıştır. Takım seçildiğinde iki farklı renk 

seçeneği ortaya çıkmaktadır. Şekil 10’da gösterildiği 

gibi, farklı renkler, takımın iç ve dış yüzeylerini temsil 

etmektedir. Takım temas yüzeyini tanımlamak için 

takımın dış yüzeyini temsil eden sarı renk seçilmiştir. 

 

 

Şekil 10. Takım temas yüzeyi (Tool contact surface) 
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İş parçası düğüm setini tanımlamak için Assembly 

Display Options diyalog kutusundaki Instance 

sekmesinde Base-mesh-1 (iş parçası) seçilerek iş parçası 

görünüm ekranına geri getirilmiştir. Menü çubuğundan 

Tools→Set→Create seçilmiştir. Açılan Create Set 

diyalog kutusunda düğüm seti adı n_all ve tipi Node 

olarak tanımlanmıştır. Son olarak, Şekil 11’de 

gösterildiği gibi, iş parçasının tüm düğümleri seçilmiştir. 

 

 

Şekil 11. İş parçası düğüm seti (Node set of workpiece) 

 

Temas özelliklerini tanımlamak için menü çubuğundan 

Interactions→Property→Create seçilmiş, açılan diyalog 

kutusundaki varsayılan IntProp-1 adı ve Contact seçeneği 

kabul edilmiştir. Edit Contact Property diyalog 

kutusunda Mechanical→Tangential Behavior ve 

sürtünme formülasyonu Penalty olarak seçilerek 

sürtünme katsayısı 0.3 olarak ayarlanmıştır. Normal 

temas özelliklerini ayarlamak için Mechanical→Normal 

Behavior seçilmiş ve varsayılan seçenekler kabul 

edilmiştir. 

Temas çiftini tanımlamak için menü çubuğundan 

Interaction→Create seçilmiştir. Görüntülenen Create 

Interaction diyalog kutusunda Int-1 varsayılan adı kabul 

edilmiş, Cutting adımı ve temas çifti tipi listesinden 

Surface-to-surface contact (Explicit) seçilmiştir. Ana 

yüzey olarak tanımlı yüzeyler listesinden Tool_surf ve 

yardımcı yüzey için n_all düğüm seti ayarlanmıştır. İşlem 

tamamlandıktan sonra, ana ve yardımcı temas çifti, Şekil 

12’de gösterildiği gibi, vurgulanmaktadır. 

Rijit gövde kısıtlamasını oluşturmak için menü 

çubuğundan Constraint→Create seçilmiştir. Açılan 

Create Constraint diyalog kutusunda, Rigid Body 

işaretlenmiş ve Edit Constraint diyalog kutusu 

görüntülenmiştir. Bu diyalog kutusunda, Analytical 

Surface bölge tipi ve tanımlı yüzeyler listesinden 

Tool_surf seçilmiştir. Referans noktası için takım eleman 

seti tanımlanmalıdır. Takım geometri setini tanımlamak 

için menü çubuğundan Tools→Set→Create seçilmiştir. 

Açılan Create Set diyalog kutusunda adı ref_geo ve tipi 

Geometry olarak tanımlanmıştır. Daha sonra, RP 

harfleriyle işaretlenmiş olan takım referans noktası 

seçilmiştir. Böylece, tanımlanan ref_geo noktası, 

referans noktası olarak kullanılmıştır. 

 

 

Şekil 12. Temas çifti (Contact pair) 

 

2.8. Sınır Koşulları (Boundary Conditions) 

İşleme sırasında, iş parçasının alt yüzeyi tamamen 

sınırlandırılmış ve yan yüzeyleri de X doğrultusunda 

kısıtlanmıştır. Kesici takım, sabit hızla −X doğrultusunda 

doğrusal olarak hareket etmektedir. Takım hızı 

değişikliğini daha düzenli hale getirmek için hıza genlik 

eğrisi eklenebilir. Ayrıca, kesici takım iş parçasını oda 

sıcaklığında işlediğinden, iş parçası ve takımın üst ucu 

için önceden tanımlanmış bir sıcaklık alanı ayarlamak 

gereklidir. 
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Takım üzerine yer değiştirme yükünü uygulayabilmek ve 

kesme kuvveti çıktısını elde etmek için ref_geo olarak 

tanımlanan takım referans noktası kullanılmıştır. 

İş parçası serbestlik derecelerini tanımlamak için düğüm 

setleri tanımlanmalıdır.  İş parçası alt kenarı düğüm setini 

oluşturmak için Load modülünde menü çubuğundan 

Tools→Set→Create seçilmiştir. Açılan Create Set 

diyalog kutusunda düğüm seti adı base_bottom, tipi Node 

olarak tanımlanmış ve alt kenardaki tüm düğümler 

seçilmiştir. 

Genlik eğrisini tanımlamak için menü çubuğundan 

Tools→Amplitude→Create seçilmiştir. Açılan Create 

Amplitude diyalog kutusunda varsayılan Amp-1 adı 

kabul edilmiş ve Tabular tipi seçilmiştir. Zaman ve 

genliğin matematiksel ilişkisi, Şekil 13’te gösterildiği 

gibi, girilmiştir. Genlik eğrisi, takım hareket hızının 

değişim sürecini sıfırdan maksimuma ve sonra sıfıra 

ayarlamayı sağlamaktadır. 

İş parçasının alt tarafına uygulanacak sınır koşullarını 

tanımlamak için menü çubuğundan BC→Create seçilmiş 

ve Create Boundary Condition diyalog kutusunda adı 

Fix_work olarak tanımlanmıştır. Initial analiz adımında 

Mechanical sınır koşulu kategorisi ve 

Symmetry/Antisymmetry/Encastre seçilmiştir. Bölge 

seçim iletisi görüntülendiğinde, base_bottom düğüm seti 

ve tüm kısıtlamaları temsil eden ENCASTRE öğesi 

ayarlamıştır. İş parçasının ön ve arka kenarlarına 

uygulanacak sınır koşulları için de yukarıdaki işlem 

tekrar edilmiştir. 

 

 
Şekil 13. Genlik eğrisi (Amplitude curve) 

 

Tool_move adlı kesici takım sınır koşulunu oluşturmak 

için Cutting analiz adımında Mechanical kategorisi ve 

Velocity/Angular velocity ayarlanmıştır. Bölge seçimi 

iletisi görüntülendiğinde, ref_geo takım referans noktası 

seçilmiştir. Takım hareketi sınır koşulları (kesme hızı ve 

genlik) Edit Boundary Condition diyalog kutusunda 

tanımlanmıştır. Sınır koşulları oluşturulduktan sonra elde 

edilen model görünümü Şekil 14’te verilmiştir.

 

 

Şekil 14. Sınır koşulları (Boundary conditions) 

 

İş parçasının başlangıç sıcaklık sınır koşulunu 

tanımlamak için menü çubuğundan Predefined 

Field→Create seçilmiştir. Açılan Create Predefined Field 

diyalog kutusunda sınır koşulu adı Temp_work olarak 

tanımlanmış ve Initial analiz adımı ayarlanmıştır. Other 

kategorisinde Temperature seçeneği işaretlenmiş ve n_all 

düğüm seti seçilmiştir. Edit Predefined Field diyalog 

kutusunda başlangıç sıcaklık sınır koşulu 298K (25C) 

olarak ayarlanmıştır. Takım referans noktası ref_geo için 

de başlangıç sıcaklık sınır koşulunu tanımlamak için 

yukarıdaki işlem tekrar edilmiştir. 

2.9. İş Başlatma (Starting a Job) 

Model oluşturulduktan sonra Job modülüne girilir. İş 

başlatmak için iş oluşturma, girdi dosyasını yazma, veri 

kontrolü ve girdi dosyasını gönderme işlemleri yapılır. İş 

oluşturmak için menü çubuğundan Job→Create 

seçilmiştir. Açılan Create Job diyalog kutusunda işin adı 

5000 olarak tanımlanmıştır. Edit job diyalog kutusu 

görüntülenmiş, varsayılan seçenekler kabul edilmiş ve iş 

oluşturma görevi tamamlanmıştır. Oluşturulan işin girdi 

dosyasını yazmak için menü çubuğundan Job→Manager 

seçilir. Açılan Job Manager diyalog kutusunda Write 

Input düğmesine tıklanır. Bu işlem sayesinde modelin bir 

girdi dosyası (inp) çalışma dizinine yazılır. Veri kontrol 

görevini gerçekleştirmek için Data Check seçeneği 

kullanılır. Job Manager diyalog kutusunda durum sütunu, 

görev yürütme ilerlemesini göstermektedir. Görev 

tamamlandığında hata yoksa, Check Completed 

görüntülenir. 

*inp. dosyasının analizini gerçekleştirmek için 5000 adlı 

iş seçilmiş ve Submit düğmesine tıklanmıştır. Şekil 15’te 

gösterildiği gibi, bu sırada ekranın altındaki pencerede 
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durum görüntülenebilir. Analiz tamamlandıktan sonra, 

elde edilen hesaplama sonuçları visualization 

modülünden çıkarılabilir. 

 

 

Şekil 15. İş ilerlemesi (Job progress) 

 

3. BENZETİM SONUÇLARI VE TARTIŞMA 

(SIMULATION RESULTS AND DISCUSSION) 

Talaş kaldırma işleminin analizi için iş parçası ve takım 

arasındaki ilk temastan talaş oluşumunun tamamen 

gerçekleşmesine kadar benzetim gerçekleştirilmesi 

gerekir. Bu çalışmada, Ti6Al4V titanyum alaşımının dik 

kesme işleminin üç farklı durumu, −30, 0 ve 30° takım 

talaş açısı, 300 m/dak kesme hızı, 0.1 mm kesme derinliği 

ve 1 mm kesme genişliği ile analiz edilmiştir. Talaş şekli, 

iş parçası yüzeyi, eşdeğer gerilme, plastik gerinim ve 

kesme kuvveti gibi parametreler incelenmiştir. 

3.1. Talaş Açısının Talaş Oluşumuna Etkisi (Effect of 

Rake Angle on Chip Formation) 

Şekil 16(a)−(c) üç farklı talaş açısı altında elde edilen 

talaş şeklini ve ağ deformasyonunu göstermektedir. Şekil 

16(a)’da görüldüğü gibi, −30’lik açıda kesikli talaş şekli 

oluşmuştur. Talaş, takım talaş yüzeyi tarafında aşırı 

deformasyona uğramış ve pürüzlü bir iş parçası yüzeyi 

görülmüştür. −30’lik negatif talaş açısı verildiğinde, 

pürüzlü bir yüzey oluşması, kesme hareketinin itme ve 

sıkıştırma kuvvetine dönüşmesi ile açıklanabilir [21]. 

Şekil 16(b), 0’lik takım talaş açısında oluşan talaş 

şeklini göstermektedir. Takımın ilerlemesiyle keskin 

testere ağızlı talaşlar sürekli olarak elde edilmiştir ve 

işlenen iş parçasının yüzeyi daha az pürüzlüdür. Testere 

dişler arasındaki deformasyon bölgesinde malzemenin 

termoplastik kararsızlığından kaynaklandığı kabul edilen 

adyabatik kayma bantları ortaya çıkmıştır [8]. Kayma 

bantları önemli derecede deforme olmuş ve benzer 

açılarda takım ilerleme yönüne doğru eğilmişlerdir. Talaş 

yüzeyine yakın taraf daha pürüzsüzdür ve diğer taraf 

testere ağzı şeklindedir. Başka bir deyişle, Ti6Al4V 

alaşımını yüksek hızlı işleme sırasında meydana gelen 

plastik deformasyon talaşın kayma yüzeyindeki 

gerilmeyi arttırmıştır. Şekil 16(c), 30’lik talaş açısında 

elde edilen benzetim sonucunu göstermektedir. İş 

parçasının yüzey kalitesini önemli derecede iyileştiren 

sürekli talaş oluşmuştur. Şekil 16(b) ve (c)’den, talaş 

açısındaki artışın işlenen iş parçası yüzeyini daha 

pürüzsüz hale getirdiği çıkartılabilir. 

 

 

Şekil 16. Talaş şekli ve ağ deformasyonu: (a)  = −30; (b)  = 0; (c)  = 30 (Chip shape and mesh deformation: (a)  = −30; 

(b)  = 0; (c)  = 30 
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3.2. Eşdeğer Gerilme Dağılımı (Equivalent Stress 

Distribution) 

Şekil 17(a)−(c), üç farklı talaş açısı için SE 

benzetimlerinden tahmin edilen iş parçası eşdeğer 

gerilme dağılımlarını göstermektedir. Her üç durumda 

da, takım ucundan talaşın serbest yüzeyine uzanan 

birincil deformasyon bölgesinde yüksek eşdeğer gerilme 

dağılımları (yaklaşık 700’den 1000’e MPa) 

gözlemlenirken, ikincil deformasyon bölgesinde daha 

düşük eşdeğer gerilme büyüklükleri (yaklaşık 350’den 

700’e MPa) görülmüştür. −30 ve 0’lik takım talaş açıları 

için talaş ve iş parçasındaki en yüksek eşdeğer gerilme 

bölgeleri yaklaşık olarak aynı büyüklüklere ve benzer 

desenlere sahip olmasına karşın, 30’lik açıda daha 

küçük bir en yüksek eşdeğer gerilme bölgesi oluşmuştur. 

Başka bir deyişle, −30 ve 0’lik talaş açılarında, kesme 

hareketi, talaşın deforme olmasını önleyen ve talaş ve iş 

parçasında daha büyük eşdeğer gerilme alanına neden 

olan itme ve sıkıştırma işlevini içermektedir [21]. 

 

 

Şekil 17. Eşdeğer gerilme dağılımları: (a)  = −30; (b)  = 0; (c)  = 30 (Equivalent stress distributions: (a)  = 

−30; (b)  = 0; (c)  = 30) 

 

3.3. Eşdeğer Gerinim Dağılımı (Equivalent Strain 

Distribution) 

−30, 0 ve 30 takım talaş açılarında elde edilen iş parçası 

eşdeğer plastik deformasyon (PEEQ) kontur haritaları 

Şekil 18’de gösterilmiştir. −30 ve 0’lik açılarda 

adyabatik kayma bantlarının oluştuğu, plastik 

deformasyon dağılımı haritası ile de doğrulanmıştır. 

Kaymadan dolayı yoğun plastik deformasyonun oluştuğu 

birincil deformasyon bölgesinde yüksek gerinim 

büyüklükleri ortaya çıkmıştır. Kong ve arkadaşları [8] 

tarafından bulunduğu gibi, adyabatik kayma bantları 

arasında kalan bölgede daha küçük deformasyon 

meydana gelmiştir ve gerinim esas olarak talaş 

köklerinde yoğunlaşmıştır. 30lik açıda yüksek 

deformasyonlar takım-talaş ara yüzüne bitişik ince bir 

tabakada gözlemlenmiştir. Bu durum, takım ve talaş 

arasındaki sürtünmeden kaynaklanmaktadır [8].
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Şekil 18. Plastik deformasyon dağılımları: (a)  = −30; (b)  = 0; (c)  = 30 (Plastic strain Distributions: (a)  = 

−30; (b)  = 0; (c)  = 30) 

 

Şekil 19, üç farklı takım talaş açısı koşulunda iş parçası 

yüzeyinde ve yüzey altında tahmin edilen eşdeğer 

gerinim değerlerini göstermektedir. Talaş açısına 

bakılmaksızın, işlenen iş parçası yüzeyinde yüksek 

gerinim değerleri oluşmuştur. Derinlik arttıkça gerinim 

değerleri aniden azalmış ve iş parçasının alt yüzeyinde 

sıfıra yaklaşmıştır. −30, 0 ve 30 talaş açılarına sahip 

takımlarla işlenmiş iş parçası yüzeyinin eşdeğer plastik 

deformasyon değerleri sırasıyla 1.74, 1.81 ve 0.28 olarak 

hesaplanmıştır. Burada, talaş açısı 0’dan 30’ye 

yükseldiğinde, iş parçası yüzeyindeki eşdeğer gerinim 

değerinin, yaklaşık 1.5’lik bir azalmayı temsil edecek 

şekilde 1.81’den 0.28’e düştüğüne dikkat edilmelidir. 

Yukarıdaki sonuçlardan açıkça görüldüğü üzere, talaş 

açısı arttırıldığında, işlenmiş iş parçası yüzeyindeki 

eşdeğer gerinim azalmaktadır. Bu durum, kesme 

kuvvetinde görülen fiziksel olay ile özdeştir. Bu nedenle, 

iş parçası yüzeyindeki eşdeğer gerinimi önemli ölçüde 

azaltmak için talaş açısını arttırmak gereklidir. 

 

Şekil 19. İşlenmiş yüzey ve yüzey altındaki eşdeğer gerinimler 

(Equivalent strains on the machined surface and 

subsurface) 
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3.4. Kesme ve İtme Kuvvetleri (Cutting and Thrust 

Forces) 

Kesikli talaş oluşturan −30’lik talaş açısında hesaplanan 

kesme kuvvetinin zamanla değişimi Şekil 20(a)’da 

verilmiştir. 0’lik talaş açısında, testere ağızlı talaş şekli 

oluşmuştur ve kesme kuvveti değişimi Şekil 20(b)’de 

gösterilmiştir. Sürekli talaş şekline sebep olan 30’lik 

talaş açısında elde edilen kesme kuvveti değişim eğilimi 

de Şekil 20(c)’de sunulmuştur. Kesikli ve testere ağızlı 

talaş kesme kuvveti değişimleri, sürekli talaş kuvvet 

değişimine kıyasla büyük dalgalanmalar ve ‘artan-

azalan’ sürekli bir döngü süreci sergilemiştir. Bu fark, 

deformasyon bölgelerinin termoplastik kararsızlığından 

kaynaklanmaktadır. Birincil deformasyon bölgesinde 

yoğun kayma deformasyonu oluşmaya başladığında 

termoplastik kararsızlık ortaya çıkar ve yük taşıma 

kapasitesi önemli ölçüde düşer. Buna bağlı olarak kesme 

kuvveti azalan bir değişim gösterir. Daha sonra, takım 

ilerlemeye devam ettikçe, yeni bir kayma bandı oluşur ve 

kesme kuvveti yavaş yavaş artar [8].

 

 

Şekil 20. Zamanla kesme kuvvetlerinin değişimleri: (a)  = −30; (b)  = 0; (c)  = 30 (Variations of cutting forces with time : 

(a)  = −30; (b)  = 0; (c)  = 30) 

 

Şekil 21, −30 ile 30 arasındaki takım talaş açılarında 

benzetimlerden elde edilen kesme ve itme kuvvetlerini 

göstermektedir. Şekilde gösterildiği gibi, −30, 0 ve 30 

talaş açılarında teğetsel yöndeki kesme kuvveti 

bileşenleri sırasıyla 148, 139 ve 108 N olarak 

hesaplanmıştır. İlerleme yönündeki karşılık gelen itme 

kuvveti büyüklükleri de 122, 71 ve 22 N’dur. Bu 

sonuçlar, takım talaş açısı −30’dan 30’ye 

değiştirildiğinde kesme ve itme kuvvetlerinin azaldığını 

göstermiştir. Dolayısıyla, takım ne kadar keskinse, 

kesme ve itme kuvvetlerinin o kadar küçük olduğu 

sonucuna varılabilir. 0 ve 30 talaş açılarında 

benzetimlerden elde edilen kesme kuvvetleri arasında, 

yaklaşık 30 N’luk bir fark vardır. İtme kuvveti 

bileşenlerinin farkı daha belirgindir ve yaklaşık 50 N’a 

kadar ulaşmıştır. 0 ve 30’lik açılarda bulunan sonuçlara 

göre, enerji tüketimi açısından takım talaş açısı 30’ye 

ayarlanmalıdır. Diğer taraftan, 0’lik talaş açılı takımın 

30’lik açılı takımdan çok daha uzun ömürlü olacağı 

unutulmamalıdır. Lo [21] tarafından da benzer sonuçlar 

elde edilmiştir. Takım talaş açısı −30’dan 0’ye 

arttırıldığında, teğetsel kesme kuvveti bileşeninin 
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değişimi çok sınırlıdır. −30’lik açıda elde edilen teğetsel 

kesme kuvveti ile 0’lik açıda bulunan kesme kuvveti 

arasındaki fark sadece 9 N’dur, bu fark o kadar küçüktür 

ki göz ardı edilebilir. Ancak, −30’lik talaş açısı altındaki 

takım ömrü, 0’lik açıdakinden çok daha uzundur. 

 

 

Şekil 21. Talaş açısı ile kesme ve itme kuvvetlerinin 

değişimi (Variation of the cutting and thrust 

forces with rake angle) 

 

4. SONUÇ (CONCLUSION) 

Bu çalışma, esasen Abaqus/Explicit yazılımı ile Ti6Al4V 

titanyum alaşımının kesme süreci benzetimi için SE 

modelleme adımlarını kapsamlı bir şekilde tanıtmaktadır 

ve farklı takım talaş açılarının talaş şekli, işlenen iş 

parçası yüzeyi, eşdeğer gerilme, plastik gerinim dağılımı 

ve kesme kuvveti üzerindeki etkilerini incelemektedir. 

Benzetim bulgularını analiz ederek, aşağıdaki sonuçlar 

elde edilebilir: 

1. −30 ve 0 talaş açısına sahip takımlarla Ti6Al4V 

alaşımının kesme işlemi sırasında, sırasıyla kesikli 

ve testere ağızlı talaş şekilleri elde edilmiş ve kesme 

kuvveti dalgalanması da oldukça belirgindir. 

Ti6Al4V alaşımının kesme işlemi sırasında en 

büyük gerilme birincil deformasyon bölgesinde, 

yüksek plastik deformasyonlar ise ikincil 

deformasyon bölgesinde talaş köklerinde meydana 

gelmiştir. 

2. 30 talaş açısındaki kesme benzetiminde, Ti6Al4V 

alaşımı iş parçasının yüzey kalitesini önemli 

derecede iyileştiren ve kararlı kesme kuvveti 

değişimi oluşturan sürekli talaş elde edilmiştir. 

3. 30’lik talaş açılı takımla işleme esnasında yüksek 

eşdeğer gerilmeler birincil deformasyon bölgesinde 

gözlemlenirken, yüksek plastik deformasyonlar 

takım-talaş ara yüzüne bitişik ince bir tabaka 

boyunca görülmüştür.  

4. Aynı kesme koşulu altında −30’lik talaş açısı en 

yüksek kesme ve itme kuvvetlerini oluşturmaktadır; 

30’lik talaş açısında karşılık gelen kuvvetler en 

küçüktür. Takım talaş açısı −30’dan 30’ye 

değiştirildiğinde, kesme ve itme kuvvetleri 

azalmaktadır. Bu sonuç, daha keskin bir takım 

geometrisi oluşması ile açıklanabilir. 
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